
Big Business Server for Windows
This Chapter covers Big Business Server for Windows and recent additions to Big
Business Documentation including:

• Setting Up Big Business Server

• Setting Up Big Business Clients

• Understanding Multi-User Features

• Server Administration
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Introduction to Big Business Server
Big Business Server is the multi-user version of Big Business™, the integrated business
management tool from Big Business, Inc..  Big Business Server is based on a client/
server architecture that supports multiple simultaneous users— all your employees can
access current information from the server.

Client/ server architecture divides data processing between the client and the server.
The division of labor between these two parts is transparent to users.  The client part is
located on the user computers.  Its responsibility is to display the Big Business interface
and to query the server in response to user actions.

The server part is located on a designated server computer.  Its responsibility is to store
and manage data and provide services to the client computers across a network.  To
search for a set of customers, for example, users ask the client to locate certain customer
cards.  The client sends the request to the server, which executes the search on the
server machine and returns the resulting customer cards to the client.

The benefits of client/ server architecture are increased efficiency and speed.  Work is
divided between the clients and the server and is intelligently managed to reduce the
amount of network passes.  The less network traffic, the faster the entire system works.
Because all data is stored on the server, each client has immediate access to
up-to-the-minute data.
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Getting Started with Big Business Server
Getting started with Big Business Server is easy.  Installation takes just a few minutes.
You use simple dialog boxes to set up the program with your company data.  If you
choose, Big Business Server can automatically set up almost everything.  You can also
import data from other programs.

This manual is an addendum to the Big Business User’s Guide.  It leads you through
installing Big Business Server on both the client and server machines.  It also discusses
the exclusive features of Big Business Server that are not mentioned in the Big Business
User’s Guide.

This chapter explains how to install and set up the software.  After you finish this
chapter, you’ll be ready to start working with Big Business.
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About this document
The first part of this document is written for the Big Business Administrator, who is
responsible for installing and setting up the Big Business client and server software.
The Big Business Administrator should also assign access privileges that are
appropriate for using the Company data file in a multi-user environment.

The second section, on Big Business Server features, can be used by anyone who is
using multi-user Big Business.
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Multi-User Licensing
Your Big Business Server installation is licensed for a specific number of
simultaneously connected clients. Although you can install the client software on any
number of machines, Big Business Server will permit logins only up to the number of
clients for which you are licensed. See “Upgrading Big Business,” later in this
document, for information on adding more users.
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Before You Start
To the Administrator: Before you begin installation, take a minute to verify that you
have what you need to set up the Big Business multi-user client/ server configuration.

Server Requirements

Windows Server:

• A Pentium or better with a minimum of 256 megabytes of RAM
• 100 megabytes of hard disk space
• Windows 2000, Windows XP, or Windows 2003

Windows  Client:

• A Pentium or better with a minimum of 128 megabytes of RAM
• 100 megabytes of hard disk space
• Windows 2000, Windows XP, or Windows Vista

Macintosh Client:

• Any Mac running Mac OS X 10.3 or higher.
• 100 megabytes of hard disk space

Network Requirements

For the network, you need:
• An Ethernet network (10/100/1000 BASE-T recommended)
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Big Business Server Notes
• The Big Business Server server-side component should be the only Big Business
software running on the server machine. Do not attempt to run a Big Business Client or
a Big Business Web Server on the same machine as Big Business Server.

• One or more of your Big Business clients can act as a Web Server for your Internet or
intranet users. The Big Business Web Server is an add-on product, activated by a
software license key.  You can test drive the Web Server Add-On from the Maintenance
toolbar in Big Business Client.
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Upgrading Big Business
The Upgrade button on the Company Card opens a dialog that allows you to add
additional users to your Big Business product license, or to purchase new products such
as the Big Business Web Server. You must be a registered Big Business user in order to
use the Upgrade button.

When you select Upgrade, a dialog displays contact information for Big Business Sales.

By calling 877-970-0022 or 925-274-9568

• You can purchase a Big Business multi-user system, or add additional user seats.
• You can purchase Big Business Web Server, which lets any one of your Big Business
systems act as a Web Server for your remote users.

You can register Big Business and enable the multi-user and/or Web server
functionality in one session. Please have your registration number available: it is
affixed to the inside back cover of the Big Business User’s Guide.

Windows Server Setup [30]Overview

Windows Server Setup [30] Overview

Click the Upgrade button on the Company Card to Add Users or to enable the Web Server.

30 - 8



Product Registration and Technical Support
Register your Big Business product to get person-to-person technical support and other
benefits. To register your Company data file, call Big Business registration at (877)
970-0022 with your serial number.

Big Business offers product support information on its Web site at
www.bigbusiness.com. For further product assistance, you can reach the Big Business
Support at (925) 274-9568. Registered Big Business users receive 90 days of free setup
support from the date of registration. Extended support is available through several
support plans.
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Installing Big Business Server on Windows
The installation program places Big Business Server on your hard disk in a location that
you specify. You can use the folder name that Big Business suggests, or enter one of
your own.

To install Big Business Server on your Windows machine:

1. Insert the Big Business CD-ROM into the CD drive.
2. The startup screen, pictured, should appear.  If not, double-click on the CD drive in
MyComputer.
3. Click “Explore this CD" to view the CD contents.
4. Open the Server60 folder
5. Double-click the server installer (e.g. "bb60xsvr.exe") to launch
6. Follow the onscreen instructions.
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Server Directory and Files
After installation, the Big Business Server directory contains:

•  The Big Business Server Engine application
•  The Data folder, which contains a Demo File
•  The ReadMe file
•  Accessory folders, DLLs, and other files required by BB Server

Start Big Business Server by selecting the Big Business Server Engine icon from the Big
Business Server folder (under Programs on the Start menu, by default). For
convenience, a Shortcut to Big Business Server is installed on your desktop.
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Launching Server
To start Big Business Server, double-click the Big Business Server shortcut on the
Desktop, or go to the Start Menu, to Programs, to Big Business Server, and choose BB
Server.

The first time you launch Big Business Server, the Open Data File dialogue will allow
you to select a data file.  When you Quit and re-launch Big Business Server, the same
data file will be automatically opened.

Hold down the Alt key immediately after launching Big Business Server to show the
Open Data File dialogue and select another data file.
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The Server Process Window
When Big Business Server launches, BB Server opens a process window containing
information about clients and processes indicating that Big Business Server is now
available for use by clients.  You must install at least one client in order to start using
Big Business Server.

Client computers, as they connect, will be listed by their network names in the Server
Process Window.  Once Big Business Server is running you should only need to refer to
the information on the Process Window to verify memory settings or check for
connected users.  Setting memory usage is described later in this chapter.
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Server System Resources for Windows
Big Business Server for Windows lets you access memory settings by choosing
Preferences from the Edit menu and clicking on System Resources under Application.

IMPORTANT:  Changing settings other than those recommended here may have
adverse affects.  Please read and follow these instructions.

Memory Settings are found in Preferences.  From the Edit menu, select Preferences,
then click on Application, then System Resources.  These settings limit Big Business
Server in its usage of memory.  The pictured settings, for example, allocate up to 5
blocks of 64000k of main memory, plus 65,536K of Cache (64MB).

For larger data files, on a server with plenty of RAM installed, you may want to
increase the Cache Memory setting to allow Big Business Server to load more of the
data file into memory during use.  The default setting is adequate for data files up to
512MB but can be increased up to the size of the data file if RAM permits.

The Cache Memory setting should never exceed built-in RAM minus 256MB.  For
example, if the server computer has 384MB of RAM installed (check the System Control
Panel), do not set the Cache Memory higher than 128MB (131,072KB).
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Preserving Data Files and Uninstalling
At any point, you can uninstall Big Business Server and run the installation program
again. Data files and other files that you created after installation will be preserved.  A
new, demo data file will be reinstalled in the Demo folder.

A Word about Data Files

The first time you start the program, Big Business Server asks which data file you want
to use.  After you have selected a data file, Big Business Server will automatically open
the same data file when launched again.  To select another data file, hold down the Alt
key immediately after launching Big Business Server.

All Big Business data files have a file extension of, ".4dd". Although Big Business Server
is designed for use with a single, production-level Company data file, you can create
one or more new, blank data files in the Data folder to practice Set Up or to prototype
your Company data file. Files in the Data folder will be preserved even if you
“uninstall” Big Business Server.

Whenever you open a New company data file, Big Business starts the Set Up process.
To create a new company data file, hold the Alt key immediately after launch, then
click New on the file dialog to create a new file.  Using Big Business Single User is
recommended for building a new data file.

All Big Business data files also have a matching resource file with a ".4dr" file
extension.  This file should be backed up along with the .4dd data file, but can be
easily replaced if necessary.  The data file (.4dd) contains all of your records and
preferences and it is critical that you backup this file on a regular basis.

Windows Server Setup [30]Installation

Windows Server Setup [30] Installation

Use the Add/ Remove Program control panel to uninstall Big Business components.

30 - 15



Serving the Data File
By default, Big Business Server always opens the last data file used. The very first time
you start Big Business Server, it asks you which data file you want to use. If you open a
blank Company data file, you can start the Set Up process. If you want to open a
different data file (for example, the Demo data file to run the Big Business tutorial),
hold down the Alt key after you launch Big Business Server. Choose the data file you
want in the dialog box that appears.

See also “A Word about Data Files” earlier in this document, following the  description
of Big Business Server installation.
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Registering BB Server as a Service
Big Business Server can be run as a Service, allowing it to start automatically when the
server computer is rebooted and before logon, and controlled by Scheduler or
scripting.  Setup must be performed by a local Administrator-level Windows user.

To configure Big Business Server as a service:
1.  Launch Big Business Server if it is not already running.
2.  From the File menu select, Unregister all 4D Server Services.
3.  From the File menu select, Register As Service.
4.  Open the Services applet to configure the service.
5.  If you want BB Server to start when the computer is restarted, set the Startup Type
to Automatic.
6.  Do not click Start to start the Service if BB Server is still running as an application.
7.  Do not remove the option to Allow service to interact with desktop or you will run
the risk of someone launching the application while the service is already running.
8.  Do not switch from using a Local System account or you will run the risk of
permission problems and/or someone launching the application while the service is
already running.
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Building a Data File
It is recommended that you Setup your Company data file using Big Business
Single-User.  The Installer for the Single-User Version of Big Business can be found on
your Server CD.  Refer to the following for information on building a new data file:

Big Business User's Guide:
Chapter 1
Chapter 13

Big Business Training Video 1:
New Company 33:50
Importing Data 43:15
Set Up Customers 50:00
Verification of Data 55:30

If you choose to perform the Setup from a Client, Big Business Server will allow only
one user to perform the Setup operation for a new data file.
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Installing Big Business Clients
The Install program places Big Business Client in Program Files or a location you
specify.

To install Big Business Client for Windows from CD:
1. Insert the Big Business CD.
2. Click “Explore” to view CD contents.
3. Open the Client folder (e.g. Client50)
4. Double-click the Client Installer (e.g. bb50xcl.exe).
5. Follow the onscreen instructions.

If you have downloaded the Big Business Client for Windows installer (e.g.
bb503cl.exe) from www.bigbusiness.com, simply double-click the installer and follow
the onscreen instructions.

The installer automatically creates Shortcuts in the Start menu and on your Desktop.

Important:
If you are installing on a protected computer, you may need to sign on to the computer
as an Administrator level user.
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Installing Client for Mac OS X
The Install program places Big Business Client on the hard disk you specify in the
Applications folder.

To install Big Business Client for Mac OS X:
1. Insert the Big Business CD or download the Client from www.bigbusiness.com.
2. Double-click the Big Business Client Installer.
3. Read the README then click the Continue button.
4. Select a destination disk to install the software.
5. Wait while the software installs, then Quit the installer.

The Applications folder where BB Client is installed will open automatically.  Open
the BB Client folder and drag the BB Client to the Dock for easy launching.

Important:
You should install the same version of Client and Server.  Install from the same CD, or
if downloading, download matching Client(s) and Server.
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Turning Off Sleep
We recommend setting the Energy Control Panel on any Macintosh used for Big
Business to Never go to Sleep.  If you update System software, Default settings may be
restored.

To set your Macintosh to Never go to Sleep:
1.  Open the Energy Saver Control Panel.
2.  Move the slider from its current setting (e.g. 30 min.) to Never.
3.  Close the Energy Saver Control Panel.

NOTES:
•  You can set the Display separately
•  Portables (PowerBooks, iBooks) have separate Battery and Power Supply settings
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Connecting Clients to Big Business Server
When you launch Big Business Client for the first time, the Connect to BB Server dialog
appears.  Click on the Local (TCP/IP) tab and select the Big Business Server.  When you
restart BB Client it will automatically connect to the same server.  Hold down the Alt
key after launching BB Client to display the Connect to BB Server dialog again.

If no server appears on the Local (TCP/IP) tab, make sure that the server machine is on,
and that Big Business Server is up and running. If you still don’t see a server in the
Data Servers area, check the network set up.

If you encounter any problems, contact Big Business Technical Support for help
resolving network difficulties.  We are happy to help ensure a reliable network setup.
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Connecting to Remote Server
To connect to a Big Business Server outside of your local network:
1.  Launch BB Client, then immediately hold the Alt key (Option on Mac).
2.  On the Connection dialog, click the Remote (Custom) tab.
3.  Enter any name and the Server IP address.
4.  Click the OK button to connect.
5.  Wait while resource files are copied from the server, which may be several minutes.

If the connection fails:
6.  Check network settings.
7.  Check with your network administrator that Port 19813 is open if a firewall is in
place.

If performance is too slow:
8.  Verify the connection speed on both ends.  Most important are the downstream
speed on the remote end (500Kb/s for low-cost ADSL/Cable), and the upstream speed
on the Server end (384Kb/s for entry-level Business DSL).
9.  Consider "remote control" using PCAnywhere, TimbuktuPro, VNC, Remote Desktop,
etc. if connection speeds are too low.
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Server Features
Big Business Server and Big Business (single-user) are virtually the same product with
identical features and interface. However, Big Business Server has sophisticated
multi-user capabilities not found in Big Business. As a result, Big Business Server
includes multi-user management features that are not discussed in the Big Business
User’s Guide.  Those features are listed in this chapter.

In a client/ server architecture, the server stores and manages a single data set that all
users access and share. This ensures that users have immediate access to current data.
The server also stores the Big Business structure and manages multiple users accessing
the same structure objects, such as screens, lists, or notes, at the same time.

Big Business provides an intelligent object-locking system that lets multiple users
access and view the same structure objects simultaneously. To protect data integrity,
Big Business allows only one user at a time to modify the object. For example, when
you try to modify a customer card that is already in use, Big Business displays a
read-only version of the customer card—you can view and print the card, but you
cannot change it until it has been closed by the other user.
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Server-Specific Features
This chapter includes instructions on these and other topics:

• Updating Lists
• In-Use Cards
• Single-Instance Tools
• Multi-User Objects
• System Maintenance
• Making Deposits
• Performing a Check Run
• Creating an Invoice

After you have completed this chapter, you will be familiar with the multi-user
features of Big Business Server. Please refer to the Big Business User’s Guide for
in-depth program and feature instructions.
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Updating Lists
When you open a tool from your Big Business Client, Big Business presents you with a
QuickChoose list.  To ensure that this list displays the most recent information
available on the server, you can click the “Update List” button.

The “Update List” request from your client causes the server to supply your client with
the most recent version of the list that exists at the time.

For example, if you want to obtain the most recent version of the Item List:

1. Click the Update List button in the list box.
2. If the list is up to date, Big Business Server sends the message “This List is up to
date”:
3. If the list is not up to date, the server sends the message “Updating List”.

Tip: When you make changes from a client, the server updates immediately. Your
client also immediately reflects the changes you make yourself.
See also “Updating Local Lists,” later in this document.
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In-Use Objects
Big Business allows multiple users to view the same object simultaneously, but only
one user at a time can actually modify the object. For example, many users can view a
customer card for A Shop For Gifts And Things at the same time, but only one user can
actually edit the card. Once that user closes A Shop For Gifts And Things’s customer
card, another user can begin making modifications immediately. Objects displayed in
this read- only mode can be viewed and printed by any number of users at a time. User
access to objects is managed on a first-come-first-served basis.

Big Business does not display a dialog box when an object will be displayed in
read-only mode.  Instead the In Use indicator is displayed.

The following is a list of the objects that Big Business displays in read-only mode:
• Customer, Vendor, Item, Contact, Employee, Company Cards
• Quotes, Orders, Invoices
• Receive Money
• Purchase Orders
• Bills
• Make a Payment tool
• Bank, Category, Account Cards
• General Journal
• Transfers
• Access
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Single-Instance Objects
Big Business won’t display certain tools in read-only mode; only one instance of the
tool can be open on the network at one time. This means that only one instance of that
tool can be open on any one client, as well. Big Business prevents access to certain
tools and operations to protect data integrity and prevent event conflicts, such as
printing duplicate checks or duplicating deposits. For instance, a user cannot do a bank
account reconciliation when another user has already started a reconciliation. Once
the first user has completed the reconciliation, the other user may begin one.

Big Business displays the following dialog box when only one instance of the tool can
be open at a time.

The following is a list of the tools that can be open in only one instance at a time.
• Prefs (except MyDesk)
• Item Adjustments
• Balance Adjustments
• Reconciliation
• Deposits
• Finance Charges
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Check Run/Schedule Payments Tools 
Check Run and Schedule Payments tools are single-instance if either is in use. Big
Business displays a dialog box when users try to use the Check Run and Schedule
Payments tools in one of these three circumstances:

• A user has the Check Run tool open and another user tries to launch the Check Run
or Schedule Payments tools.
• A user has the Schedule Payments tool open and another user tries to launch the
Schedule Payments or Check Run tools.
• A user has either the Check Run or Schedule Payments tools open and the same user
tries to launch the other tool.
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Multi-User Tools
Big Business allows some objects to be opened and modified by multiple users at the
same time. However, if more than one user is logged on to the server under the same
login name, these objects are available only to the first user with that login name.

Big Business displays the following dialog box when an object is not available to
multiple users with the same login name.

The following is a list of the tools that are available to multiple users (but not to more
than one user logged in under the same login name):

• Notes
• Dated Notes
• Filed Notes
• MyDesk Prefs
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System Maintenance
The Administrator cannot perform maintenance on the system when other users are
signed-in. If the Administrator launches the Maintenance Prefs tool when users are
signed-in, Big Business displays the dialog box below.

Before doing maintenance on Big Business, wait until all users have signed off the
server.
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During Maintenance
Conversely, users will not be able to log on to the system when the Maintenance Prefs
tool is active. Big Business displays the following dialog box when a user tries to sign
in and another user is currently performing system maintenance.
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Performing a Check Run
To ensure the accuracy of all checks being printed, Big Business will not let a user
perform a check run if one or more of the bills in the check run has been modified or
deleted by another user. In such a case, Big Business displays the following dialog box.
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Creating an Invoice
When you open an existing sales order and another user tries to create an invoice for
the open sales order, the other user will see the following dialog box.
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Making Deposits
To ensure the accuracy of all deposits, Big Business will not let a user make a deposit if
one or more of the items in the deposit is being modified by another user. In such a
case, Big Business displays the following dialog box.
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